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A1A1A1A1    Revision HistoryRevision HistoryRevision HistoryRevision History    

No. Date Subject 

0.n  Preliminary documents, changes without notice. 
1.0 March 13, 2007 First released document. 
1.1 October 26, 2010 Revised. 

AAAA2222    CopyrightCopyrightCopyrightCopyright    
Copyright © Alpermann+Velte Electronic Engineering GmbH 2002.  All rights reserved. No 
part of this publication may be reproduced, translated into another language, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise without the prior written consent of Alpermann+Velte 
Electronic Engineering GmbH. 

Printed in Germany. 

Technical changes are reserved. 

All brand and product names mentioned herein are used for identification purposes only, and 
are trademarks or registered trademarks of their respective holders. 

Information in this publication replaces all previously published information. Alpermann+Velte 
Electronic Engineering GmbH assumes no responsibility for errors or omissions.  Neither is any 
liability assumed for damages resulting from the use of the information contained herein.  

For further information please contact your local dealer or: 

Alpermann+Velte 

Electronic Engineering GmbH 
Otto-Hahn-Str. 42 
D-42369 Wuppertal 
Phone: ++49 - (0)202 – 244 111 0 
Fax: ++49 - (0)202 – 244 111 5 
E-Mail: info@alpermann-velte.com 
Internet: http://www.alpermann-velte.com 
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A3A3A3A3    General RemarksGeneral RemarksGeneral RemarksGeneral Remarks    
This manual is a supplement to the “Installation & Systems Manual RUBIDIUM SERIES”. It 
describes a special operating mode of an AI or DI or HI module realized by the appropriate 
firmware. Please read the below listed chapters of the “Installation & Systems Manual 
RUBIDIUM SERIES”, as these chapters are necessary for the safe and proper use of Rubidium 
module AI or DI or HI. 

  

• A3 Warranty, 

• A4 Unpacking/Shipping/Repackaging Information, 

• A5 Safety Instructions, 

• A6 Certifications & Compliances, 

• Plug-In a Module, 

• Remove a Module. 
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1 Functional Description 

1.1 Overview 
The option “CLIP” for a RUBIDIUM Module (AI or DI or HI) has been developed to operate 
together with an automation system. While the automation system runs the playlist, a simple 
command can be transmitted to transfer the clip length to the RUBIDIUM module. The module 
starts a DOWN counter, converts this time into an LTC format, and visibly inserts the time onto 
a video monitor. Choose the Rubidium module according to the video system: 

RUB AT: CVBS analogue video 525/60 (NTSC) or 625/50 (PAL). 

RUB DT: Digital video channel (SD). 

RUB HT: SD or HD video channel.  

The special RUBIDIUM module is able to transfer the data in a time code format to further 
RUBIDIUM modules, so the time can visibly inserted on different video channels. External time 
code reader units are able to decode and display the time of the DOWN counter. 

These are the key features of the system: 

• Various serial protocols selectable. 

• Depending on the protocol, up to two stop watches can be set independently: Counter 1 
and Counter 2.  

• Once set, the module counts the time automatically. The DOWN counter stops at zero. 
Having a video signal connected, the counter synchronizes to the video frequency. 

• Time code can be generated in an LTC format. The time of Counter 1 will be transferred to 
the time information, Counter 2 to the binary groups (user bits) of the time code – or vice 
versa. Having a video signal connected, the LTC output will be phase-locked to the video 
signal. 

• Time code frame rate selectable: 24/25/30/30drop. 

• Counter 1 and Counter 2 can visibly be inserted onto a video monitor. The video windows 
can be positioned over the entire screen. Size, brightness, background mask, etc., can be 
adjusted. 
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1.2 Configuring the RUBIDIUM Module 
Upon delivery the RUBIDIUM module has got a setup to a basic configuration. The following 
guide describes the most important setups and enables you to find the configuration for your 
special environment. This example shows screen shots of the PC program tabs configuring an 
AI module. 

1. “Factory Settings”: Start the configuration after a “Reset” of the module. 
Activate the “Profile” page and select: Profile: Factory SettingsFactory SettingsFactory SettingsFactory Settings 

Click on the OKOKOKOK button. 

 

2. Serial: Select the parameters of the serial interface.  

 

This special module uses only the following parameters. These parameters have to 
be identical to those of the source (transmitter):   

Interface RS232, RS422 or RS485. 

Termination Having RS422 or RS485 selected a termination can be selected. 

Baudrate 2400, 4800, 9600, 19200, 38400, 57600, 115200. 

Data Bits 7 or 8. 

Parity None, even or odd. 
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3. Clip: Select the serial protocol and configure the counters. 

 

Protocol 

The RUBIDIUM module receives data according to one of the following protocols: 

HH:MM:SS “Hours : Minutes : Seconds” in ASCII format: 
HH:MM:SS<CR> 

HH:MM:SS.FF “Hours : Minutes : Seconds . Frames” in ASCII format: 
HH:MM:SS.FF<CR> 

BFE HH:MM:SS “Hours : Minutes : Seconds” in ASCII format: 
<STX><*ADDR>HH:MM:SS<ETX> 

LOUTH HH:MM:SS “Hours : Minutes : Seconds” in ASCII format: 
Three commands will be accepted: 
<STX><*ADDR><E>HHMMSS<ETX> = set time 
<STX><*ADDR><D><ETX> = start DOWN 
<STX><*ADDR><R><ETX> = reset 

OMNIBUS/TSL HH:MM:SS “Hours : Minutes : Seconds” in ASCII format: 
<HEADER> 00h HH:MM:SS 
<HEADER> = 80h + address (81h or 82h) 

<*ADDR> = address ASCII (31h or 32h). 
The address selects Counter 1 or Counter 2. 
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Time Code 

Time/User Swap The time of Counter 1 will be transferred to the time informa-
tion, Counter 2 to the binary groups (user bits) of the time 
code.  If you click on this check box this arrangement will be 
reversed.     

Framerate Select the framerate of the time code: 24/25/30/30 df. 
Having a video signal connected the frame rate has to match 
to the picture frequency of the video, for example: 
Framerate = 25 in a 625/50 television system (PAL), 
Framerate = 30 df in a 525/60 television system (NTSC). 

Counter 1 

Configuration of Counter 1. 
To compensate for delays (e.g. produced from the serial interface or from the 
video path) an offset can be programmed. This offset is defined by a number of 
frames and can have a plus or minus sign. 
Utilizing the RUBIDIUM CONFIGURATION PC program you enter a number 
pressing the tabulator key at the PC’s keyboard afterwards. 
Use Offset If you click on this check box any counter start value (received 

by a serial interface command) will be added or subtracted 
with the offset, the result will be the counter’s set value.    

Offset Sign + or – and number of frames (0 – 63). 

Counter 2 

Configuration of Counter 2, same way as for Counter 1. 
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4. Adjust the video windows: 

The video window can be adjusted according to your needs. 

Please notice the ‘Source’ and ‘Format’ selection! Because the time code generator 
will be the source of the counters, ‘Source = Generate’ has to be selected. One 
counter will be identical to the time addresses of the time code (‘Format = Time 
...’), the other counter will be contained in the binary groups or user bits of the 
time code (‘Format = User ...’). 

For example the time of Counter 1 at “Window 1“: 

 

For example the time of Counter 2 at “Window 2“: 
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1.3 Connecting the Serial Interface 
The SERIAL DSUB connector at the rear of the RUBIDIUM module has the inputs for the serial 
interface. Three types of interfaces can be used: RS232 or RS422 or RS485. Please connect 
only those signals (pins) as described. 

RUB
AI/DI/HI

DSUB9
RS232:

5: GND
6: RTS Output
7: RxD Input

11

Alpermann+Velte

GPISERIAL

DSUB9
RS422:

5: GND
6: R- Input
7: R+ Input

DSUB9
RS485:

1: TRA (-)
2: TRB (+)
5: GND

 

Example of connecting to the RS232 of a PC: 

DSUB9
RUBIDIUM

5: GND

6: RTS Output

7: RxD Input

DSUB9
PC

5: GND

8: CTS Input

3: TxD Output  
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1.4 LTC Output 
The LTC output is available at two connectors: 

3-pins XLR male LTC, 

9-pins DSUB female SERIAL/LTC OUT. 

11

Alpermann+Velte

GPISERIAL/LTC OUTLTC

 

 

 

XLR3M: 

1 2

3

 

LTC 
1: GND 
2: LTC_OUT_A 
3: LTC_OUT_B 

 

SERIAL/LTC OUT 
DSUB9F 

3: LTC_OUT_A 
4: LTC_OUT_B 
5: GND 

 

The LTC carries a down-counting time, so the LTC will be coded as running “reverse”. 
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2 Modules AI, DI and HI 

2.1 Overview 
The hardware consists of the video channel, the inputs for the serial interface, the LTC output, 
and some general purpose interfaces which may be used for various special applications (GPI 
in/outputs). 

A PC is required for the initial set-up and for configuration of this module. The front panel 
label visibly identifies where each module is located:  

AI: CVBS analogue video 525/60 (NTSC) or 625/50 (PAL). 

DI: Digital video channel (SD). 

HI: SD or HD video channel. 

The serial number is located on the bottom side of the lower circuit board of each module. 

The standard hardware of this module has all of the following key features:  

• “Hot Swapping“, i.e. it is possible to insert or remove a module without interrupting the 
operation of other modules in this frame. 

• Failure relay, connected to the FAIL_A and FAIL_B pins of the RLC connector at the rear of 
the frame. 

• RS232 and TC_link (RLC connector) interfaces to have access to the internal bus of the 
chassis. 

• Video input/output to insert characters. 

• LTC generator. 

• Serial interfaces RS232, RS422, RS485. 

• Four programmable function keys on the front panel. 

• Flash memory containing the firmware, so configuration and updates are possible via a 
PC connection (email attachments with software/firmware update files are possible). 

• Four digital in- or outputs and one relay contact may be used in special applications. 
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2.2 Rear Panels and Connections 
Connections at modules AI/DI – version 1 Connections at modules HI and AI/DI – version 2 

GPISERIAL
11

VIDEO OUTVIDEO INLOOP OUT

Alpermann+Velte

 

11

SERIAL GPI

VIDEO OUTLOOP OUTVIDEO IN

Alpermann+Velte

 

Pin assignments 

SERIAL 
DSUB9F female 

1: T-_TxD 
2: T+_CTS 
3: LTC_OUT_A 
4: LTC_OUT_B 
5: GND 
6: R-_RTS 
7: R+_RxD 
8: GPI_3 
9: GPI_4 

 

GPI 
DSUB9F female 

1: GPI_1 
2: GPI_2 
3: GPI_3 
4: GPI_4 
5: GND 
6: 24 VDC Out 
7: GPI_5 
8: LTC_IN_A 
9: LTC_IN_B 
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Signal descriptions 

GND Signal ground. 
 

LTC_OUT_A, LTC_OUT_B Balanced LTC (Linear Time Code) output. 
 

LTC_IN_A, LTC_IN_B Reserved. 
 

T-_TxD 

T+_CTS 

R-_RTS 

R+_RxD 

In- or outputs of the local serial interface. By configuration 
one of the following electrical interface can be selected: 

RS485: signals T- and T+, balanced in/output. 

RS422: signals T- and T+ = balanced output, 
signals R- and R+ = balanced input. 

RS232: TxD = transmit line, unbalanced data output. 
CTS = clear to send, handshake input. 
RTS = request to send, handshake output. 
RxD = receive line, unbalanced data input. 

 

GPI_1 ... GPI_4 General Purpose Interface, may be used as input or as 
output for digital signals according to application. 

 

GPI_5 Relay contact (normally open). The relay contact shortens 
this pin to GND. 

 

24 VDC Out 
 

24 VDC voltage output, 200 mA reversible fused. This 
output corresponds to the voltage output of the inserted 
“Power Supply“ module. Please notice the power supply 
specifications. 

 Using this output please make sure not to exceed 
the total power rating of the “Power Supply“ module. 
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2.3 Specifications 
Video channel VIDEO IN/LOOP OUT/VIDEO OUT 

 AI DI HI 
Format  CVBS analogue video: 

PAL 625/50, 
NTSC 525/60 

Serial digital (SD) video, 
ANSI/SMPTE 259M 

Serial digital HD video, 
SMPTE 292M 
or 
serial digital SD video, 
ANSI/SMPTE 259M 

Connector BNC (IEC169-8), 75 Ω BNC (IEC169-8), 75 Ω BNC (IEC169-8), 75 Ω 
Signal level 
VIDEO IN 

1 V ± 15 mV 800 mV ± 10 % 800 mV ± 10 % 

Signal level 
LOOP OUT 

Loop-through of 
VIDEO IN 

800 mV ± 10 % 800 mV ± 10 % 

Signal level 
VIDEO OUT 

 Gain 1 ± 1 % 
(adjustable ± 4 %) 

800 mV ± 10 % 800 mV ± 10 % 

LTC Output 

Format according to ANSI/SMPTE 12M-1-2008 
Connector Balanced signals LTC_OUT_A and LTC_OUT_B, 

• via the 3-pins XLR male connector LTC, 
• via 2 pins of the DSUB female connector SERIAL/LTC OUT. 

Output impedance < 50 Ω 
Frame rates 24, 25, 30, 30-Drop 
Signal level Adjustable 140 mVp-p - 4.9 Vp-p 

GPI 

GPI_1 ... GPI_4: 
Input specification 

Input “Low“: -2.0 to +1.0 V 
Input “High“: +3.0 to +24.0 V 
Impedance: 4,7 kΩ 
Frequency: 0 - 1 MHz 

GPI_1 ... GPI_4: 
Output specification 

Open Collector output of a NPN transistor at 4k7 pull-up 
resistor (5 VDC). Max. power dissipation: 200 mW. 

„High“ state: 4.3 V (no load). 

„Low“ state:  Output switched to GND. 
Max. collector current: 100 mA DC, fused by a 100 mA auto-

recovery fuse. 
Collector-emitter saturation voltage: 

@100 mA: typ. 200 mV (≤ 600 mV), 
@10 mA: typ. 90 mV (≤ 250 mV).   

Frequency: 0 - 150 kHz. 

GPI_5: 
SPST-NO relay 

Contact resistance:  0.2 Ω 
Max. switching power:  10 W 
Max. switching voltage:  175 VDC 
Max. switching current: 0.5 A 
Max. transportable current: 0.8 A 
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24 VDC Out 

Output of the DC power 
supply of this module, 
normally = 24 VDC. 

Reversible fused. A continuous current of up to 120 mA can 
be applied over the whole specified operating temperature 
range. At an ambient temperature of e.g. 22 °C the output 
switches to a high-resistance state after a few seconds if a 
current of 300 mA is applied. 

Others 

Operating voltage 12 - 30 VDC 
Power consumption AI module: Max. 5.0 W 

DI module: Max. 4.5 W 
HI module: Max. 6.2 W 

Weight 0.4 kg approx. 
Mechanical 2 circuit boards (W x D): 100 x 160 mm / 3.94 x 6.30 inch 

Rear panel: Rub H1: 103 x 44 mm / 4.06 x 1.73 inch 
  Rub H3: 8HP, 3RU 

Environmental character-
istics, operating 

Temperature: 5 °C to 40 °C 
Relative humidity: 30 % to 85 %, non-condensing 

Environmental character-
istics, non-operating 

Temperature: -10 °C to +60 °C 
Relative humidity: 5 % to 95 %, non-condensing  
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2.4 Software Update 
Software updates require a (windows operating system) computer and the “RUBIDIUM 
CONFIGURATION“ program. 

Please check the PC connector at your RUBIDIUM housing: There is an USB or RS232 (with a 
DSUB9 connector) interface installed. You now need the same interface at your computer.  

The new firmware should already be stored as a .tcf.tcf.tcf.tcf file at your computer. 

Please now execute the following steps: 

1. Connect your computer to the PC connector of that RUBIDIUM frame where the module 
has been plugged. 

In case of an RS232 interface: Use a straight (1:1) connection between the PC connector 
at the RUBIDIUM frame and the RS232 of the computer. 

In case of an USB interface: Use a USB A-B cable between your computer and the 
RUBIDIUM frame. 

Switch on the power of all units. 

2. Execute “Rubidium Config.exe” on your computer. Select the “Port” according to the 
interface (USB, RS232) you are using. 

3. Select the module (unit 1, 2, 3 ...). 

4. Select “Flash Update“ in the File menu. 

5. Open the .tcf-file. Standard name: “Rubidium AI OPT41 version.tcf“ or 
“Rubidium AI (v2) OPT41 version.tcf“ or 
“Rubidium DI OPT41 version.tcf“ or 
“Rubidium DI (v2) OPT41 version.tcf“ or 
“Rubidium HI OPT41 version.tcf“. 

“version” stands for a revision no., e.g. 2.0.184. 

Click the OK button, update starts. Click the OK button at the end. 

6. Update is finished now. We recommend to check module’s configuration utilizing the 
“RUBIDIUM CONFIGURATION“ program. 

 

During the flash update the operation of the module stops! 
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3 The Rubidium Configuration Tools 

3.1 The Rubidium Configuration PC Program 
Please refer to the 

“Installation & Systems Manual RUBIDIUM SERIES” 

for a general description of this program and how to install it. At this document please notice 
the following subchapters: 

• Overview 

• Installation 

• Connection to RUBIDIUM SERIES Chassis 

• Starting the Program 

• Store, Load and Update the Configuration on your PC 

• The “Profile” Tab: Store and Load Configurations on the Module 

• The “System” Tab: Module Identification, Reset, SNMP, Fan Control … 

The program RUBIDIUM CONFIGURATION uses various tab cards. With one click on the 
button Configure, all available and currently activated tabs of this specific module are 
displayed. 

Any changes at a tab will immediately be stored at the module. If you enter a number or a text 
press the tabulator key at the PC’s keyboard afterwards. 
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3.2 The Rubidium Series HTTP Server 
Please refer to the 

“Installation & Systems Manual RUBIDIUM SERIES” 

for a functional overview and for an installation description of this program. You will find the 
chapter “The RUBIDIUM SERIES HTTP Server” and its subchapters: 

• Overview, Connecting the IE Module 

• IP Configuration, the Rubidium Homepage 

• Access to a RUBIDIUM SERIES Module 

• The “Profile” Page: Store and Load Configurations on the Module or on the PC 

• The “System” Page: Module Identification, Reset, SNMP, Fan Control … 

As soon as a communication to a single module has been established, the Configuration 
page gives a list of all the links, which correspond to all the currently available or used pages 
of this specific module. 

Changes at a page will not be stored at the module automatically. At the bottom of each page 
there are two buttons which should be used to store or load the module’s configuration: 

Button Save To Module: 

• Click on this button to transfer all settings on this page to the module. 

Button Reload From Module: 

• Click on this button to load the current configuration of the module. 

 

AI
 

Every time you click on the blue button which indicates the module under 
configuration a Reload will be done automatically. 
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3.3 “Functions“ 
Click on Functions to see all applicable tabs/pages listed, and to activate or deactivate 
tabs/pages. For example (screen shot of the PC program tab): 

 

A tab/page reflects a function of the module. The columns Edit and Use determine whether 
the function in the module is activated/deactivated and whether user configuration of that 
specific function is allowed or not.   

Click on the applicable Edit and/or Use check boxes to activate/deactivate a function:  

Edit Use  

  Function is deactivated, the tab is not visible. 

√ √ Function is activated, the tab is visible and configurable. 

 √ Function is activated but the tab not visible and therefore not configurable. 

 

• We suggest that you deactivate the Use check boxes of all functions you are presently 
not using.  

• We suggest that you deactivate the Edit check boxes of all functions you are presently 
not configuring. That avoids unintentional operating and malfunctions. 

List of tabs/functions: 

System: Identification, Reset, SNMP Traps, Fan Control … (*1) 
Keys: Keys, Lamps, LEDs and GPIs 
Video: Video System and General Setup of the Video Channel 
Insert: Setup of all Video Windows 
LTC Generate: LTC Generator Function (*2) 
Serial: Serial Interfaces (*2, *3) 
Clip: DOWN Counter Adjustment (*2,*3) 
Profile: Store and Load Configurations on the Module (*1, *2) 

*1: Refer to “Installation & Systems Manual RUBIDIUM SERIES” 

*2: This is a basic function of this special module, so no Edit and Use check boxes have 
been provided. 

*3: Refer to chapter “Configuring the RUBIDIUM Module”.  
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3.4 “Keys“: Keys, Lamps, LEDs and GPIs 
The module has four illuminated buttons (keys and lamps), four LEDs (Light Emitting Diodes) 
and four GPIs (General Purpose Interface). The functions of these in- and outputs are 
programmable. 

Some functions are assigned to special options, and therefore are not applicable with the 
standard firmware. For further information, please contact Alpermann+Velte. 

Configuration (example shows a screen shot of the PC program tab): 

 

Function Keys 

Four keys F1, F2, F3 and F4 can get a function independently from each other. Select a 
function from the dropdown list. This selects the function of the lamps as well. 

 
LED 

Four LEDs (named OPER, SIGNAL, SET and ERROR) can get a function independently from 
each other. Select a function from the dropdown list. 

 
GPI 

Four GPIs can get a function independently from each other, as an input or as an output. 
Additionally the switching characteristic (as a push button or a toggle switch) is selectable. 
Select from the dropdown lists. 
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3.5 “Video“: Video System and General Setup of the 
Video Channel 

3.5.1 Module AI: Analogue Video Channel 

“AI” modules have a CVBS analogue video channel. 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of video standard. 
625/50 PAL system. 
525/59.94 NTSC system. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Video Bypass By Relay: Option B only (Video Bypass Relay): Enables to manually switch 
to video bypass. 

 
Insert 

Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. 

 
If you change the “Character“, “Mask“ and “Transparency“ setup you should verify the 
changes, so make sure to have a video window inserted, and connect the video output to a 
video control monitor. 
 

Character: Draw the slider to adjust the brightness of all the inserted characters. 

Mask: Draw the slider to adjust the brightness of all the background masks. 

Transparency: Draw the slider to adjust the mixing of video signal and character insertion. 
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3.5.2 Module DI: Digital Video Channel (SD) 

“DI” modules have a serial digital video channel (SD). 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of the video standard. 
625/50 PAL system. 
525/59.94 NTSC system. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Channel: Setup of the video output: 
Off Video output switched off. 
On Normal operation: The video input signal passes through the 

video channel; signals will be added as programmed (visible 
video windows).  

Pass Thru The video input signal passes through the video channel, but 
the video signal will be left unchanged.  

Short Pass Thru The video input signal will be left unchanged and will be 
passed to the output with minimum delay. 

Relay Bypass Option B only (Video Bypass Relay): Enables to manually 
switch to video bypass. 

Width: Format of the serial data words: 8 bit or 10 bit. 

Insert Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. The input to output delay will be left unchanged. 



Option “CLIP” Clip Length Inserter 
Page 23 

 

3.5.3 Module HI: Digital Video Channel (HD or SD) 

“HI” modules have a high-definition digital video channel (HD or SD). 

Configuration (example shows a screen shot of the PC program tab): 

 
System: Select the video standard: 

Auto Auto-detect of the video standard. 
All other Select the video standard from the dropdown list. 

It is recommended not to use the “Auto” mode if the module operates only at 
one video standard. 

Channel: Setup of the video output: 
Off Video output switched off. 
On Normal operation: The video input signal passes through the 

video channel, signals will be added as programmed (visible 
video windows).  

Pass Thru The video input signal passes through the video channel, but 
the video signal will be left unchanged.  

Short Pass Thru The video input signal will be left unchanged and will be 
passed to the output with minimum delay. 

Relay Bypass Option B only (Video Bypass Relay): Enables to manually 
switch to video bypass. 

Width: Format of the serial data words: 8 bit or 10 bit. 

Insert Enable: If this check box is activated: All video windows which have the “visible” check 
box activated (see the Insert tab) will be inserted in the video signal. 

If this check box is deactivated: Bypass of the video signal, i.e. all the video 
windows will be switched off. The input to output delay will be left unchanged. 

Video Stream Processing 

Activate or deactivate some data processing functions – independent for Video IN and Video 
OUT handling. 
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3.6 “Insert“: Setup of all Video Windows  
Each video window can get an individual setup. It is recommended to connect the video output 
to a video control monitor so you can verify the changes at this tab immediately. 

Configuration (example shows a screen shot of the PC program tab for a DI or HI module): 

 

Window: Select the video window, all the following setups refer to this window. 

Visible: Click on the control box to select “visible” (window insertion switched on) or not 
visible (window insertion switched off). 

 
Position 

Horizontal: Adjust the horizontal position of the video window: Enter a number and press 
the tabulator key at the PC’s keyboard or click on the arrow keys by the side 
of the window. 

Vertical: Adjust the vertical position of the video window: Enter a number and press the 
tabulator key at the PC’s keyboard or click on the arrow keys by the side of 
the window. 

  Click on these buttons to set the video window at the upper/lower border of the 
screen. The horizontal position will be left unchanged. 

 Click on these buttons to set the video window at the most left/center/most 
right position of the screen. The vertical position will be left unchanged. 
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Values 

TC1  10 : 59 : 28 : 13  G1
Pre Text Source/Format

Delimiter
Identifier
Post Text  

Pre Text: A text can be placed right before the source characters. Enter the text and press 
the tabulator key at the PC’s keyboard. 

Source: Select the data source from the drop-down list. 

Format: Select the data format (representation of the data) from the drop-down list. 

Delimiter: Select the delimiter from the drop-down list, if the data format uses one. 

Identifier: You can add a source identifier following the source characters. Select from the 
drop-down list: 
Off = No source identifier. 
Letter = One character, e.g. “G” for generator. 
String = Two characters plus possibly a field identifier, e.g. “VR1” stays for VITC 

reader data of the first field. 

Post Text: Instead of an identifier (“Identifier = Off“) you can add a text following the source 
characters. Enter the text and press the tabulator key at the PC’s keyboard. 

 

Character 

Font: Select the character font from the drop-down list: 

Font Pixel Matrix max. characters max. windows 
 H x V (*) horizontal (about) vertical (about) 
16 10 x 16 63 32 
20 12 x 20 52 25 
24 14 x 24 44 21 
28 16 x 28 39 18 
36 20 x 36 31 14 
48 27 x 48 23 11 
64 35 x 64 17   8 
72 39 x 72 16   7 
(*: Pixel clock horizontal = 13.5 MHz, vertical = “interlaced“ video line) 

Color: Module DI and HI only: Select the colour of the character insertion. The current 
colour is indicated. Click on the Change... button to change the colour. Refer to the 
description below for more information. 
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Mask 

A background mask can be added to the character insertion. Select from the drop-down list: 
 
Mode: Off No background mask. 

Solid With background mask. 
Dimmed Module DI and HI only: Reducing the luminance of the video signal in 

the video window area. 
 
Color: Module DI and HI only: Select the colour of the background mask (“Mode” = “Solid” 

only). The current colour is indicated. Click on the Change... button to change the 
colour. Refer to the description below for more information. 

 

Module DI and HI only: 

Change...: Select the colour of the character insertion or the background mask: 

 
Click on any of the colour boxes to use an already defined colour: “Basic color” 
or “Custom color”. 

If you want to define your own colour you can: 

• Enter a value in the Hue, Sat, Lum boxes. 

• Enter a value in the Ret, Green, Blue boxes. 

• Select colour and saturation: Use the mouse button to draw the pointer at 
any place within the colour spectrum. Select brightness: Use the mouse 
button to draw the pointer at any place within the brightness bar. 

Press the OK button at the end. 
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3.7 “LTC Generate”: LTC Generator Function 
Adjust the output of the LTC (Linear Time Code). 

Configuration (example shows a screen shot of the PC program tab): 

 

Gain: Select the output level from the drop-down list. 

Mute: LTC output mute on/off! 

PC bit: If this check box is activated: The polarity of the synchronization word of the LTC 
output will be stabilised. The polarity correction bit is put in a state, so that every 
80-bit word contains an even number of logical zeros. The polarity correction bit is 
bit no. 27 in the 525/60 system, no. 59 in the 625/50 system. Activating this 
checkbox is helpful if you do some LTC measurements with an oscilloscope. 
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4 Options 

4.1 Option B: Video Bypass Relay 
With this option the module is equipped with a bypass relay: 

• The bypass relay appears in the video input to output path, not in the video loop path. 

• The main functionality is to maintain the video path even in an event of power failure. 

• The bypass relay can be switched remote controlled by a GPI function: A function key 
or one of the GPI inputs can be programmed with the “GPI: Relay Bypass” function 
(see the “Keys” page of a Rubidium configuration tool). 

 

Technical data of the relay: 

Module AI 
Initial insulation resistance  100 MΩ minimum 
Initial contact resistance 50 mΩ maximum 
Max switching power 24 W  
Max switching current 1 A 
Max switching voltage 24 V 

Module DI 
Cutoff frequency  1 GHz 
Insertion loss < 1 dB 
Impedance 75 Ω 
Max switching power 24 W  
Max switching current 1 A 
Max switching voltage 24 V 

Module HI 
Cutoff frequency  2.6 GHz 
V.S.W.R. Max. 1.5 
Insertion loss < 1 dB 
Impedance 75 Ω 
Max switching power 1 W  
Max switching current 0.5 A 
Max switching voltage 30 V 

 


